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Digital Time Switch Crono Pro  

Digital Time Switch Astro Pro+  

Digital Time Switch Astro Pro    

1

The Advance time switch is a programming clock which enables the automatic switching
ON-OFF different loads on the basis of a timed programming that is sufficiently flexible to 
allow or exclude the activation depending on the day of the week.

Following product variants available in each single channel and Double channel configuration.
 For detailed description along with  CAT ID refer below table.

1. OVERVIEW

Supply Voltage

AT1SCDS AT2DCDSWT2DCDS AS1SCDS AS2DCDS
Functions

WT1SCDS

Relay Output 1 2 1 12 2

240 110-240
(VAC) 110-240 110-240240 240

Crono Pro Astro Pro+ Astro Pro

Astro

Multifunction
Cycle

Pulse
Time Switch

Lat/Long

City

Program 
Memory 50 50 50 50 50 50 

(Per channel)

- -
- -

- -
- -

- - - -
- -

- -
- -
- -

- -
- -
- -
- -

Holiday 10 10 10 10 10 10 
Program



•  Monitoring of load service hours to display alarm and plan maintenance/other activity

2. FEATURES

•  LCD Display with green backlight

•  Precise time programming for Daily / Weekly /Pulse /Astro switching

•  Bar graph for intuitive representation of daily program

•  Two separate relay outputs (  with independent programming 16A each)

•  Settable DST feature 

•  Latitude / Longitude database for 45 countries and 280 cities

•  Settable Latitude / Longitude precise to the minute with time zone

•  Sunrise/Sunset or Twilight trigger modes

•  ZCD assistance for inrush current management and for better relay & load life

•  12/24 hour display format

•  Excellent battery backup with 6 years battery reserve

•  Simple reset & Manual override

•  Password protection for settings

ASTRO PRO+

2



3. CONNECTION DIAGRAM

TERMINAL TORQUE & CAPACITY 

Ø 4.5 mm

AWG

0.5 N.m (4.4 Lb.in)

2  1 x 4.0 mm Solid/Stranded Wire

26 to 10

A) 1 Channel Device B) 2 Channel Device

Note- All dimensions are in mm

4. MOUNTING DIMENSION

RoHS

     

1. Always follow instructions stated in this product booklet.
2. Before installation, check to ensure that specifications agree with intended application.
3. Installation must be done by skilled technician.
4. Automation and controlled devices must be properly “installed” so that they are
    protected against any risk of involuntary actuations.

 CAUTION:

3

NL

18 15 16

0 6 12 18 24

GIC

36

66.2

49.2
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 5. OPERATING MODES

4) ASTRO MODE: 
1. It allows user to program the output as per Sunrise and Sunset time along with OFFSET
    time if required.
2. User can also program output OFF time during execution of ASTRO program.

 
1) SWITCH MODE :

1. It allows user to program the output channel for set time period in a day or for multiple 
    days in a week.
2. User has to define start and end time along with output action ON or OFF.

2) PULSE MODE :

 

1. It allows user to make output channel ON for short duration.
2. Duration ranges from  minimum 1 sec to maximum 59 sec.
3. User has to define start time and duration of Pulse in the program.

    

5) PERMANENT :SWITCHING
1. This mode allows User to make output permanently ON or OFF. 
2. The output will remain in this mode till User deactivate the mode.
      

  6) : 
  

 

TEMPORARY OVERRIDE
   This mode allows User to override current state of output.

      E.g. If current state of output is ON then using override mode User can change the 

      output state to OFF (or vice a versa) till execution of next scheduled program.  
7) PRIORITIES:
   

 
                                                        

In case of multiple programs calls action on output at same time, it will be operated as
   per following priority,

1. PERMANENT OFF
                                                          2. PERMANENT ON 
                                                          3. OVERRIDE
                                                          4. HOLIDAY OFF
                                                          5. HOLIDAY ON
                                                          6. PROGRAM OFF
                                                          7. PROGRAM ON

4

3) CYCLE MODE :

 

1. It allows user to make output ON and OFF in a cyclic manner.
2. User has to define Start and End period along with ON and OFF duration.

    

Start Time

 Cycle ON Duration

B

Start Time
 hh:mm Start Time

 Pulse Duration

A

A

B

c  Cycle OFF Duration

Start Time
 hh:mm

Start Time

 Action either ON /OFFB

A

B

c  End Time

Start Time
 hh:mm

End Time
 hh:mm

A

C

B

A

B

A

C



6.DISPLAY

SYMBOL DESCRIPTION

Bar Graph :
It consist of 48 segments which indicates 24 hours of    
a day with a resolution of half  hour.

Display current weekday on main screen and menu name  

Ø 
Ø 

Ø 

Ø 

Ø 

Ø Display current date on main screen and menu setting   

Display current weekday in  menu setting and also for  

Display current time.

mode during program.

main screen.

during program.

Ø  ON segment in Bar graph indicates that output will
be ON at that time of the day. Also it indicates menu 
depth in menu/edit mode.

It is updated whenever day changes or at program edit.Ø 

5

6.1. Display Description

1

2

3

5

0 2418126

4

For symbols 
refer Table 1 

For keys
refer Table 2 

1

2

3

5

4
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Ø 
   Temporary Override is deactivated by using same hot key or next program event.

 6.2  Key Operations 

6.3 Combined Key Operations for temporary override mode

   

 

       Pressing both keys together will change the present output
     state of Channel 1.
     Repressing both keys together again will restore the output
     state of Channel 1.
 

Ø 

Ø 

       Pressing both keys together will change the present output
     state of Channel 2.
     Repressing both keys together again will restore the output
     state of Channel 2.
 

Ø 

Ø 

ESC     
To enter the menu.

    To return to main screen or previous menu.
    To abort changed value or parameter. 

UP         
     To view parameters upward.
     To change/increment parameter value in edit mode.

DOWN  
     To view parameters downward.
     To change/decrement parameter value in edit mode.

ENTER      To select and save parameter value in edit mode.

RESET
     To reset hardware when device doesn't respond or hangs.

Ø 

Ø 

Ø 

Ø 

Ø 

Ø 
Ø 

Ø 
Ø 

     It doesn't change any of the user settings and clock.Ø 

     It is small key located in between Up and Down key.Ø 

SYMBOL DESCRIPTION

Display output channel number.
For 2 Channel product, display toggles between CH1 and CH2  

  number after every 7 sec with 5 sec ON  and 2 sec OFF time.

Display relay status ON/OFF of respective channel CH1 or CH2 

Ø 
Ø 

Ø 

Ø 

Ø 

Ø Indicates that output is ON/OFF due to Temporary Override 

Indicates that output is ON/OFF due to Permanent  mode. 

Indicates that output is ON/OFF due to  Holiday program.

 Indicates that output is ON/OFF due to Astro mode. Ø 

Ø Indicates that output is ON/OFF due to Time Switch mode. 

Ø Indicates that output is ON due to Pulse or Cyclic mode.

Ø Pulse mode is indicated by single pulse.

Ø Cyclic mode is indicated by dual pulse.

mode.

 Ø Blinking indicates DST is applied.

Ø Indicates day and night time.
Ø Sun indicates day time.

      Ø Half moon indicates night time.

Table 2

Table 1

+

+



 7. MAIN MENU

 Press ESC      key to enter in to Main menu.

7

0 2418126 0 2418126 0 2418126 0 2418126

0 24181260 24181260 2418126

Ø 

 Press Up     Down    key to select menu.Ø 

Press Enter     key to select sub menu. Ø 

NOTE !- In edit mode, If no push button is pressed for 40 seconds, device exit from edit 
mode.



 7.1 PROGRAM

8

0 2418126 0 2418126

0 2418126
0 2418126

0 24181260 2418126

C!

0 2418126

Ø  

 

 Program Menu is used to write new programs for selected channel.

User can also View, Modify, Delete existing program.

 Channel selection is only available for two channel device.

Ø 
 

Ø 

Ø 

There are 6 sub menu under Program Main Menu.
Channel -> New -> View->Modify -> Delete -> End

In Switch, Cycle and Pulse programming, user get   following options for Start timeØ  

1. USER TIME

2. SUNRISE TIME

3. SUNSET TIME

 and End time selection

Using Up    Down    key select  Channel CH1/CH2.



7.1.1 New

 Flow to Write New Program

A) SWITCH Mode B) CYCLE Mode

If select NO for ‘With Date’ option then program get saved without date and operate as 
weekly time switch.
As per above procedure other programs can be enter and saved.

9

Ø 

Ø 

CHANNEL  C1/C2 

start day 

start time

end day

end time

action on/off

with date

save

NEW

PRO NO

switch

CHANNEL C1/C2 

start day 

start time

end day

end time

CYCLE on/off

with date

save

NEW

PRO NO

cYCLE

C) PULSE Mode

CHANNEL C1/C2

start day 

start time

end day

end time

PULSE on 

with date

save

NEW

PRO NO

switch

DURATION

DURATION

*

Ø  Change parameter value or status by pressing  Up         and Down    key.

Ø 

Ø 

After changing parameter value press Enter     key to accept value 
move to next digit or parameter.
After completion of parameter editing, press Enter     key to save all parameters.

of parameter and

Press ESC      to enter programming ( Edit) mode.Ø 

NOTE ! - 1. Channel selection option only for 2 

 channel device.

2. By default whole week is selected for 

Start and End day selection. 
3. To deselect any weekday press down 
    key and to select any weekday press 

up     key. 
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7.1.2 View

To verify, the switching times have been correctly programmed use this sub menu.

By using this menu, direct go to Main screen.

7.1.5 End

 To go to previous menu, use ESC      key.

7.1.4 Delete

To delete single or multiple programs use this sub menu.

Ø 

Ø 

CHANNEL C1/C2

PRG 01

SWITCH /

CYCLE /

PULSE

Then press Enter     key to check all settings one by one.  

Use Up    Down    key to select the program number.

Ø 

Ø 

Use Up    Down    key to select the channel. Ø 

7.1.3 Modify

The program can be modified in this sub-menu.

view

CHANNEL C1/C2

PRG 01

SWITCH /

CYCLE /

PULSE

Then press Enter     key to confirm program to be modified.  

Use Up    Down    key to select the program number.  

Ø 

Ø 

Use Up    Down    key to select the channel.Ø 

modify

 

By pressing Enter    key modified program get saved.

Ø 

Ø 

As per program type, Set new values as per subsection 
7.1.1 NEW..

CHANNEL C1/C2

single delete

delete

 alldelete

DELETE ?

NO/YES

Use Up    Down    key to select single delete or multiple 

Use Up    Down    key to select the channel 

Use Up    Down    key to confirm delete with No/Yes 

 program will be  Then press Enter     key selected 

Ø 

Ø 

Ø 

Ø 

 deleted for single delete and if selected multiple delete   

To abort Delete option, press ESC     key.Ø 

delete program.

then all programs will be deleted.

Ø 
option. 



7.2 CLOCK

Second option is Clock Menu which is used for various clock settings.

24

0 2418126

24

0 18126

There are 8 sub menu under Clock Main Menu.
Date/Time -> Time Format -> Week Start Day ->  Date Format -> 
Location ->Twilight -> DST -> End

0 24181260 2418126

0 24181260 2418126

0 181260 2418126

0 2418126

7.2.1 Date/Time

Date/Time menu is used to set Date and Time manually.

11

Ø 

Ensure that before clock setting respective country’s time zone/Location is set.Ø 

date/time

year

month

day

hour

minute

saved

Use Up    Down    key to select the parameter value. 

 Then press Enter     key to save parameter and go to 

Ø 

next parameter setting.  

After setting, press enter     key to save date and time.Ø 

Ø 

 NOTE !- This setting reflects on main screen display and in Program setting. 
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7.2.2 Time Format

Time Format is used to set time format either 24 hours or 12 hours (AM/PM).

time FORMAT

AM/PM

saved

Use Up    Down    key to select the time format. 

 Then press Enter     key to save format.

Ø 

Ø 

date FORMAT

mm.dd.yy

saved

7.2.3 Date Format

For date format setting, Worldwide 3 different formats are usual, as listed below.

Use Up    Down    key to select the date format as listed below. 

 Then press Enter     key to save format.

Ø 

Ø 

   

7.2.4 Week Start Day

This menu is used to set start day of week. 

week start day

Sunday

saved

DD:MM:YY , Ex- 08-07-20
MM:DD:YY , 
YY:MM:DD , 

Ex- 07-08-20
Ex- 20-07-08

Use Up    Down    key to scroll week days and Enter     key 

 Select week start day from Saturday to Sunday.

Ø 

Ø 

to save week start day. 

 NOTE !- This setting reflects on main screen display and in Program setting. 
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locationT

country

india

By  Up    Down    key select the country and 

 Then press Enter     key to save format.

Ø 

Ø 

   

7.2.6 Twilight

twIlight

enable

saved

Using Up    Down    key scroll enable/disable and Enter     Ø 
 key to save.

 NOTE !- This setting reflects on main screen display and in Program setting. 

 7.2.5 Location

Coordinate menu is used to set location details and time zone.

pune

saved

locationT

coordinate

sign latitude

Degree latitude

minute latitude

sign longitude

degree longitude

minute longitude

time zone

saved

Ø 

Ø 

 
 

 

 
For Latitude setting, enter sign of Latitude i.e. South or North. Then degree followed 

  by Same parameters enter for Longitude for Sign East or West.minute of latitude.  

To scroll digit use Up    and down    key. 

Ø  Then select time zone from list, to save setting use Enter    key.

For save and update next parameter use Enter    key.

 respective cities. 

Country 

Coordinate

Ø 

 Twilight is the soft glowing light from the sky when the sunThis is energy saving mode. 

  by the reflection of the sun's rays from the atmosphere. is below the horizon, caused 

ENABLE- Device will operate at [Sunset+Twilight time] 

DISABLE- Device will operate as per Sunset/Sunrise time

Country Coordinate

[Sunrise-Twilight time] which saves energy.  

   Even after Sunset, there is sufficient light in the sky & generally there is no need to 
   switch  on Lights/Load exactly at Sunset. So if Twilight feature is used, then light will 
   get On after some time from Sunset. This time is calculated automatically.
  
   Thus it saves energy & reduce Electricity bill as well.

Ø 

Ø 

Ø 



On DST event, date and time automatically get updated.

User can select DST from options available in menu. User can either select country 
 or set manually by FIX DST or CUSTOM DST option.

Ø 

Ø 

By using Up    and Down    keys, select required settings and to save press Enter     key.

7.2.7 DST

 DST Setting Country Chart

 

Ø  By using this menu, direct go to Main screen.

7.2.8 End

14

Ø To go previous menu use ESC key.

Ø 

N OTE !  - To avoid settings at day changeover, the time 9.01 PM- 11.59 PM is blocked in 

 setting range.

NO DST- No changeover  Ø 

FIX DST- Changeover as per  user set date & time. By default 1 hour offset time. Ø 

CUSTOM DST- Changeover as per user set date & time. Here user get access to set  Ø 

  from 1 Minute to 2 Hours.offset hour range .

Europe

Country

USA

FIN/GR/TR

CDN

GB/IRL/P

Country Start
Month

Start

Week

Start
Weekday

Start
Time

End
Month

End
Week

End
Weekday

End 
Time

March

March

March

March

April

Sunday

Sunday

Sunday

Sunday

Sunday

Last
week

2nd
week

Last
week

Last
week

1st
week

2:00

2:00

1:00

3:00

2:00

October

November

October

October

October

Sunday

Sunday

Sunday

Sunday

Sunday

Last
week

1st
week

Last
week

Last
week

Last
week

3:00

3:00

2:00

4:00

3:00

Offset
Time

1:00

1:00

1:00

1:00

1:00

DST

NO DST

 
dst

custom dst

start month

start week

start hour

start minute

end week

end month

offset hour

offset minute

saved

saved

NO DST FIXED DST CUSTOM DST

SELECT COUNTRY- Changeover as per below table.Ø 

dst

fixed dst

start month

start day

start hour

start minute

end day

end month

saved
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7.3 MANUAL

There are 3 modes under Manual Menu. 

Permanent ON

Permanent OFF
Override ON/OFF

 Once any mode activated, then to deactivate setting user has to goto same menu and 

 Symbol for particular mode is displayed  at bottom row as shown by red circle.

Ø 

Ø 

   Permanent ON  
 

 

 

Override ON/ OFF :

Ø 

Ø 

Ø 

 

 

 

 

When relay is in ON state, Override OFF will appear in manual  menu and when relay  
        is in OFF state, Override ON option will  appear in manual menu.

After selection display returns to the manual menu window.

This setting affect on main screen display and in program setting. 

Ø 

Ø 

Ø 

      E.g. If current state of output is ON then using override mode User can change the 

      output state to OFF (or vice a versa) till execution of next scheduled program.  

This mode allows User to override current state of output.

Temporary override can also be achieved by hot keys operation.Ø 

0 24181260 2418126 0 2418126

NOTE ! - Only one Channel (CH1/CH2) symbol will be displayed at a time.

CHANNEL C1/C2

PERMANENT ON

saved

   Permanent Off 
 

CHANNEL C1/C2

PERMANENT OFF

saved

   Overide ON/OFF  
 

CHANNEL C1/C2

OVERIDE ON/OFF

saved

select setting. 

By using Up    and Down    keys, select required settings and to save press Enter     key.Ø 

Channel selection option only for two channel device.Ø 



0 2418126

7.4 HOLIDAY

0 2418126 0 2418126 0 2418126

0 24181260 2418126

There are 7 sub menu under Holiday Main Menu.
Chanel Selection->Channel Status-> New -> View-> Modify ->  

0 2418126

7.4.1 Channel Status

Ø 

Ø 

 
  After selecting press Enter      key to save  selected status.

16

0 2418126

C!

Delete-> End

 ENABLE -Holiday Program for selected channel will execute as per set. 

 DISABLE -Holiday feature for selected channel will not available. 

By using Up    Down    key status can be changed. 

CHANNEL selection option only for two channel device. 

        CH1/CH2.By using Up    Down    Keys select channel 

Ø 

Ø 

 Holiday mode can be set on any channel of the device. Channel output can be set as
 ON/OFF during holiday period.

th
 For example- If user select holiday start event at 10:15 of 17  March 2018 and Holiday

th
 end event at 07:00 of 30  May 2018 & select channel action as ON. 

th th Then, Channel output will be ON from 10:15 of 17  March 2018 till 07:00 of 30  May 

Ø 

User can also View, Modify, Delete existing program.Ø 
 

2018.
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7.4.2 New

 

CHANNEL C1/C2

channel status

savednew

prg no

start year

start month

start day

start hour

start minute

End day

end hour

end minute

action on/off

saved

As per above procedure other programs can be enter and saved.Ø 

Ø  Change parameter value or status by pressing  UP         and Down    key.

Ø 

Ø 

After changing parameter value press Enter     key to accept value 
move to next digit or parameter.
After completion of parameter editing, press Enter     key to save all parameters.

of parameter and

7.4.3 View

To verify, the switching times have been correctly programmed use this sub menu.

channel c1/c2

view

prg no

Using Up    Down    key select the parameter value. 

 Then press Enter     key to save parameter and go to 

Ø 

next parameter setting.  

After setting, press enter     key to save date and time.Ø 

Ø 

Then press Enter     key to confirm program to be modified.  

Using Up    Down    key select the program number to be  

Ø 

Ø 

Using Up    Down    key select the channel to be modify.Ø 

modify.

 

By pressing Enter    key modified program get saved.

Ø As per program type, Set new values as per subsection 
8.4.2 NEW..

Ø 

channel c1/c2

modify

prg no

save

7.4.4 Modify

The program can be modified in this sub-menu.



7.4.5 Delete

To delete single or multiple programs use this sub menu.

channel c1/c2

delete

single delete

Using Up    Down    key select single delete or multiple 

Using Up    Down    key select the channel which 

Using Up    Down    key confirm delete with No/Yes 

 program will be  Then press Enter     key selected 

Ø 

Ø 

Ø 

Ø 

 deleted for single delete and if selected multiple delete   

To abort Delete option, press ESC key.Ø 

program to be delete. 

delete program.

then all programs will be deleted.

Ø 
option. 

By using this menu, direct go to Main screen.

7.4.6 End

 To go to previous menu use ESC key.

Ø 

Ø 

delete o/yesN

18
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7.5 ASTRO TIME 

This is fifth sub menu in Main Menu. By using this menu user can get information for
 Sunrise and Sunset Times.
 Press Enter     key to view between Sunrise and Sunset.

    For step wise back stage use ESC     key.

Ø 

Ø 

Ø 

astro time

sunrise 

sunset



7.6 OPTIONS 

0 2418126

0 2418126

0 2418126 0 2418126 0 2418126 0 2418126

0 24181260 2418126

There are 7 sub menu under Options Main Menu.
Operating Hours -> Multifunction -> Back light-> Password -> 
Factory Restore->Device Info-> End

7.6.1 Operating Hours

20

This option enable user to set and monitor load service hours. After completion of service 
hours, Device display alarm which can be used for maintenance or other activity.

Service     

                  Here user can set operating hours, After which he Ø 

User can set operating hours for individual channel. 

View Hour

In this menu, user can check how much time of 

After completion of service hour, display shows 

Ø 

Ø 

Ø 

operating hours

channel c1/c2 

view hour

delete

service

end

intend to generate alarm message. 

service hours completed.

message "Service CH1" or "Service CH2" which flash 
after every 5 seconds. 

Delete

For deleting operating hours, Confirm the deletion by selecting “YES” and press the Ø 

To clear service message on display  user need to clear service hours by using this Ø 

Enter    key, then counter is reset to zero.

 Also during service hours in progress user can clear it.menu. 



 1 Min ON-     

Whenever any key pressed device will prompt to enter the password.

40 seconds after the last time the key was pressed the timer is automatically locked  

For security reason there is provision of password in 

7.6.3 Back light

7.6.4 Password

.

Ø 

Ø 

Ø 

Ø 

 

 

 

 

By default, password is disabled.

    again. 

By enabling password access to unauthorized user is 

ENABLE- 

7.6.2 Multifunction

Ø 

Ø   Continuous ON- When Mains is ON, back light will be continuously ON. 

Whenever there is key pressed, back light will ON for 1minute.

Ø 

Ø 

User get access to menu, only when he enter correct password.

Ø To disable password user has to enter the menu by entering correct password and using 
disable option password setting can be disabled.

After confirming with Enter key time switch is locked with the password entered.Ø 

Ø 

DISABLE- 

No any password is required to edit settings.

    Enable - User get access to set multifunction like Switch, Pulse, Cycle in new program Ø 

    Disable - Cycle and Pulse function are hide and not accessible in new program setting.Ø 

21

NOTE !-Backlight remains OFF in case of power absent.

multifunction

enable

saved

 Then press Enter     key to save setting.Ø 

Ø Use Up    Down    key select Enable/Disable selection. 

backlight

continues on

saved

1Min ON/ Continuous ON.    

Ø Use Up    Down    key select required option 

 Then press Enter     key to save format.Ø 

password

enable

saved time switch. 

restricted.

setting.



In this Menu, user can reset all setting and programs to factory reset while RTC (clock

7.6.5 Factory Restore 

and Date ) remains unchanged.

22

7.6.6 End 

By using this menu, direct go to Main screen.

 To go to previous menu use ESC     key.

Ø 

Ø 

Ø 

TIME FORMAT 

DATE FORMAT                          

 WEEK START DAY               

TWILIGHT                                

DST                                        

HOLIDAY CHANNEL STATUS      

MULTIFUNCTION                      

BACK LIGHT 

PASSWORD 

SUNDAY      

DD.MM.YY

DISABLE

DISABLE

ONE MINUTE

DISABLE

NO DST

DISABLE

24 Hours

SETTING DEFAULT VALUE

ENABLE- 

factory restore

restore ?

no/yes

done

Any settings made previously are overwritten. Ø 

The factory settings are loaded as per below table. Ø 

 Using up     down    key, Confirm restore with No/Yes  then press Enter    key.  Ø 



2 C/O

110-240 VAC

Display

Number of Programs

RTC Accuracy

Day Setting

Reset

Clock Mode

Pulse Duration

Clock Resolution (Min)

Hour Setting

+/- 0.5 sec/day @25  C  °

Hardware reset and to be used only when device doesn't respond or hangs.

Monday to Sunday

50 (Each channel) + 10 Holiday (Each channel)

6 Lines Text LCD, Viewing Angle- Backlight- 6 O’ Clock, Green 

Either 12 Hour (AM/PM) or 24 Hour Clock

00-23 for 24 Hour clock and 01-12 for 12 Hour clock

1 Minute

1-59 seconds

8. TECHNICAL SPECIFICATIONS

Astro Pro+

AT1SCDS AT2DCDS

Supply Voltage (    ) 240 VAC

Supply Variations -20 % to +10 % (Of      )

6 VA
Power consumption

Battery Back up

Operating Frequency

Approx. 6 Years

50/60 Hz

Number of Keys 4 keys [ESC, UP, DOWN, OK] & 1 RESET key

Utilization Category

(AC-1)

Contact Rating

Contact Arrangement

Incandescent Lamps

Contact Material

Electrical Life 50,000 cycles @ rated load

   Max switching: 10 A (NO & NC) at 250 VAC, Cos Φ = 0.6 

Max switching : 16 A (NO & NC) at 250 VAC, Cos Φ = 1 

16 A (NO & NC)@ 240 VAC/24 VDC (Resistive)

2600 W

1 C/O 

AgSnO2   

Operating Temperature

Other Characteristics

Humidity

-15  C to +55   C 

95% Rh (Non Condensation)

               2000 mMaximum Operating
Altitude

Storage Temperature

Enclosure

Degree of Protection

Pollution Degree

Flame Retardant UL-94 V0

-20  C to +70  C

IP-20 for Terminals ;IP-40 for Enclosure

2

Mounting

Weight (Unpacked)

Operating Position

Approx. 1 Channel - 110gm, 2 Channel - 140gm

Din Rail

Any

Supply Characteristics

Functional Characteristics

Relay Output Characteristics

Environmental Characteristics

23

Product Standard

IEC 60730-1 and IEC 60730-2-7

(Max)

° ° 

° ° 



24

9. EMC, SAFETY & ENVIRONMENTAL SPECIFICATIONS   

Voltage Flicker & Fluctuation IEC 61000-3-2    Class A

ESD

Electrical Fast Transients

Radiated Susceptibility

IEC 61000-4-4    Level IV

Power Frequency Magnetic Field  

Conducted Susceptibility

IEC 61000-4-8    Class 4

IEC 61000-4-6    Level III 

Voltage Dips & Interruption (AC)

Surge

Radiated Emission

Test Voltage (Input & Output) IEC 60947-5-1    2.5 KV

Conducted Emission

Test Voltage(All Terminal to Body)

Single fault

Impulse Voltage (Input & Output)

IEC 61010-1      

IEC 60947-5-1    Level IV

Leakage Current UL 508               <3.5 mA

Cold Heat

Insulation Resistance

Dry Heat

IEC 60730-1       >7 Mohm

IEC 60730-1       3 KV

CISPR 11            Class B

CISPR 11            Class B

IEC 61000-4-11

IEC 61000-4-5    Level IV  

IEC 61000-4-3    Level III 

IEC 61000-3-2    Class A

IEC 61000-4-2    Level III 

IEC 60068-2-1   

IEC 60068-2-2  

Vibration IEC 60068-2-6     10 to 55Hz, 5 g

Environmental  Compliance

Safety  Compliance

 Harmonic Current Emissions

EMI/EMC Compliance
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10. SERVICE CONTACT DETAILS   

Product improvement is continuous process. For the latest information and special  
Please contact GIC to reach our branch office.applications 

CONTACT US

General Industrial Controls Private Limited.

T – 107, MIDC Bhosari,
Pune – 411026,
Maharashtra, INDIA.

                                      Tel: +91-20 4623 2323

                          Tel: +91-20 4623 2329

 Tel: +91-20 4623 2325

Board Line:  

International Sales:

Domestic Sales:                               

export@gicindia.com

marketing@gicindia.com
sales@gicindia.com

https://www.gicindia.com/get-in-touch/

Kindly treat, recycle or dispose of this equipment in an environmentally sound 

E-Waste Regulatory notice :

manner after End of Life, as per WEEE (Waste Electrical and Electronic 
Equipment) regulations; or hand it over to General Industrial Controls Pvt. Ltd, 

through website 
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